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第一章  系統安裝需求 

硬體需求 

1. 支援 iFIX 6.0(含)以上版本。 

2. IBM 相容電腦，一般桌上型電腦或工業電腦皆可。 

3. Pentium-4 1GHz 或是更高等級 CPU 

4. DRAM 512 MB 以上。 

5. 600 MB 磁碟容量以上。 

6. DVD ROM 光碟機一台 

7. 至少一個空的 PCI 介面插槽 (PCI Slot)。 

8. 一個平行埠(parallel port, Printer Port ,25 Pin 母頭)或 USB Port(for dongle)。 

9. 至少一條電話線(類比 or 數位)，請先確認公司內的交換機是否提供類比線路。 

10. 如需執行模擬模式，需具有音效卡與喇叭。 

11. 如需錄製語音檔，需具有麥克風。 

 

已經測試過相容電話交換機 

⚫ NEC-308 數位電話交換機 

⚫ Panasonic KX-TES824 數位電話交換機 

 

第一節 軟體需求及使用聲明 

1. 作業系統為 Microsoft Windows 7 以上。 

2. Microsoft .net Framework 4.0 以上。 

3. 圖控軟體 iFix 6.0(含)版本以上。 

4. 如需發送[警報撥號失敗訊息]電子郵件，需提供可用的 SMTP Server。 

5. 本軟體模組之智慧財產權屬本公司所擁有，軟體與內容皆受著作權法、國際著作權條約以

及其它智慧財產權有關法律及條約保護。 

6. 非經本公司書面同意，乙方不得以任何形式或方法，將本軟體模組或其任何元件（包含內

嵌軟體與內容）進行出租、轉讓、複製、修改、解除單機授權使用限制或超出授權數量共

用本軟體；亦不得對本軟體或其任何元件進行分解、反編譯、反組譯或實施任何反向工程。 

7. 使用本軟體模組之功能如因客戶系統需求而修改、調整、安裝測試、故障排除或教學，則

本公司將需視需求內容予以報價。 

8. 有關軟體應用模組由本公司授權使用之，其授權使用內容以提供授權檔案為依據。 
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第二章  安裝語音卡與驅動程式 

第一節 安裝語音卡 

1. 關閉電腦電源，拆開電腦機殼，將語音卡插入一個空的 PCI 插槽，並鎖好固定螺絲，裝回

機殼。 

2. 連接 1~n 條電話線到語音卡的 RJ-11 接孔，建議從 port 1 依序接上。 

3. 將 Envox CT ADE 硬體保護鎖插在所安裝電腦的平行埠(parallel port)或 USB Port 上。 

4. 重新開機。 

5. 重新開機啟動後如果看到以下畫面，先點選[取消]。 
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安裝語音卡驅動程式 

iCallAlarm 警報語音自動通報系統所使用的語音卡之驅動程式有兩個部份：硬體 Driver 

(Dialogic System Software)與軟體 API(CT ADE)。 

驅動程式必需依固定順序安裝，方可正確驅動語音卡。先將 Dialogic System Release 原

版光碟片放入所安裝電腦 CD-ROM/DVD-ROM Driver 中。 

 

第一項 安裝 Dialogic System Release x  

以管理者身份執行安裝光碟根目錄下的 Dialogic SR x.x PCI for Windows SU 

xxx\Setup.exe。 

 

點選 Next 
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點選 Next 

 

 

請依照預設資料夾不要修改。點[Next] 

 

 

請依照預設資料夾不要修改。點[Next] 
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只要勾選 Core Runtime Package，然後按下 Next 

 

 

點選 是(Y) 
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請依照預設資料夾不要修改，然後點選 Next 

 

 

點選 Next 

 

 

勾選「永遠信任來自 Dialogic Inc」，點選 安裝 
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安裝完成後需重新開機。 

 

點選 Finish 

 

如果重新開機後會出現"找到新硬體"，並自動開啟尋找新增硬體精靈，如下畫面: 

 

此時如果直接按[下一步]並無法自動安裝完成，而且裝置管理員將出現" ! PCI Device" 

之錯誤裝置。 
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要解決此問題，請選取"從清單或特定位置安裝" 

 

 

點選[瀏覽]，指定到 C:\Program Files\Dialogic\Driver\32-bit資料夾，按下[下一步] 
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進行安裝。 

 

最後會看到以下畫面，表示順利安裝完成。 

 

畫面右下角應該會出現"你的新硬體已安裝且可使用"之訊息。 

  

Trendtek群
泰
科
技



iFIX 警報語音自動通報系統(iCallAlarm) 安裝手冊 

 

10 

 

檢查驅動程式是否正確安裝 

開啟裝置管理員檢查，控制台→系統管理工具→系統→裝置管理員，裝置管理員

應出現如下畫面 
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接著將電話線接到語音卡 Port 1 ~ Port n，開啟[開始\所有程式\Dialogic System 

Release\Configuration Manager → DCM  

 

點選 Connect 

 

出現連接中畫面，稍等數秒鐘。 

 

  

Trendtek群
泰
科
技



iFIX 警報語音自動通報系統(iCallAlarm) 安裝手冊 

 

12 

 

下圖表示已經偵測到一張語音卡，紅色燈號表示尚未啟動。 

 

點擊工具列[綠色三角箭頭]按鈕(Start All enable devices)啟動語音卡。螢幕右

上方會出現 iCallAlarm (電腦名稱) Start ……..進度顯示，稍後數十秒服務啟動後，燈

號會變成綠色，表示該語音卡已經正確啟動。 

 

點擊功能表 Settings→System/Device autostart→Start System，改為自動啟動。

點擊 File→Exit 離開，語音卡硬體設定已經完成。 
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下圖表示已經安裝一張語音卡，綠色燈號表示可用。 

 

 

下圖表示系統沒有安裝或沒偵測到語音卡。(如果電腦沒有安裝語音卡，Dialogic 可

以模擬語音卡讓你測試) 
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安裝 Envox CT ADE 

放入光碟片，以管理者身份手動點擊 Envox\CT ADE xx\Setup.exe。(請注意安

裝的版本) 

 

點選 Next 

 

 

點選 [I Accept] 
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請不要更改資料夾位置，點選 [Next] 

 

 

選擇預設的 Complete 模式，點選[Next] 
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點選 [Next] 

 

 

點選 Next 
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安裝中… 

 

 

點選 [確定] 

 

安裝完成出現以下視窗，請仔細閱讀。 

 

點選 確定。 
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點選 Finish。 

 

常見問題: 

如果此時執行 iCallAlarm，可能發生 CT ADE 版本不一致錯誤。請執行以下的更

新版本動作可解決問題。建議依照順序安裝，最後再執行 iCallAlarm。 
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第二項 安裝 CT ADE Dongle 

請務必先將 Dongle 插上 Print Port(or USB port)，否則自動資源掃描將限制只能使

用模擬模式(SimPhone)，無法使用實體電話線路，且 TTS 無法使用。CT ADE Profile

無法看出授權內容，需使用 CT ADE License Upgrade 功能檢視。 

CT ADE授權檢查方法如下： 

開始→程式集→ Syntellect→ License Upgrade 

 

按下 View Current License 
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結果如下圖： 

 

Number of Ports = 2 表示有兩個 Port 有授權。 
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第三項 設定 CT ADE Profile 

請務必先將 Dongle插上 Print Port(or USB port)，並將電話線插入語音卡，否

則自動資源掃描將限制只能使用模擬模式(SimPhone)，無法使用實體電話線路，且

TTS、Fax 及語音辨識等特殊功能無法使用。步驟如下： 

開始→程式集→ Syntellect →Configure CT ADE Profile 

出現 Configure Profile 對話窗後，點擊選單欄 File→Recreate profile→Discard and 

recreate 
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\Techs[R4AgTrunk]\DevCount=4 表示有四個實體電話線埠(但不表示已接上四條電

話線)。 

View→Resource summary 如下 
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常見問題: 

如果已經安裝語音卡與驅動程式，也接上了 dongle，卻無法看到實體電話線埠數量 

\Techs[R4AgTrunk]\DevCount=4 ，表示語音卡服務未自動啟動 

 

 

沒有將語音卡服務設為自動啟動，執行 程式集→ Dialogic System 

Software→Configuration Manager - DCM，點擊功能表 Settings→System/Device 

autostart→Start System，改為自動啟動請將語音卡服務改為自動啟動。 
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第三章  iCallAlarm安裝設定 

安裝 Microsoft .net Framework 4.0 

如果你的電腦尚未安裝 Framework 4.0 以上的版本，請執行安裝光碟  \ 

Framework 4.0 目錄的 dotnetfx35.exe 安裝 "dotNetFx40_Full_x86_x64.exe "。 

 

安裝 iCallAlarm 系統 

只要將磁片內 iCallAlarm 目錄下所有檔案(包含了子目錄\img、\Voices)複製到

同一個目錄下即可。接著請到安裝的目錄下，將 AlmUserQ.EXE 複製到 iFix 安裝的

根目錄。  
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檢查授權檔案 

iCallAlarm 執行時，會檢查 Trendtek.lic 的授權檔案。請將安裝光碟內的 Trendtek.lic

授權檔案或是群泰公司寄給你的 Trendtek.lic 授權檔手動複製到你剛才安裝的目錄

下，如 C:\Program files\Trendtek\Trendtek iCallAlarm 資料夾下。 
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第四章  啟動程序 

iCallAlarm 自動語音警報通知系統必須與 iFix同時運行在同一台電腦上。所以建議將啟動

指令加入到 iFix SCU Task configuration 中。你也可以將指令加在[開始\所有程式\啟動]

內，但你需注意起動順序，此系統必須待 iFix啟動完成後，iCallAlarm 才能啟動。 

若程式被關閉，可由 開始→Trendtek→iCallAlarm→iCallAlarm 手動啟動系統。 

 

 

啟動程序設定步驟如下： 
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 開啟 iFix SCU 環境 

開始→程式集→ Proficy HMI SCADA - iFIX x.x→System Configuration 
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AlmUserQ.EXE 設定 

在 SCU 視窗，點擊功能表[Configure\Task ….] 

 

按下 Filename 右邊的[…]尋找按鈕，然後挑選 ALMUSERQ.exe(若找不到此檔案，請

參考第三章\第二節安裝 iCallAlarm 系統)。注意:最好用向上箭頭將此

ALMUSERQ.exe 移至第一順位。 

 

在 Command Line 欄位輸入/ntricallalarm /s200(注意大小寫)。參數說明如下 

/n：alarm queue 名稱，必須為 tricallalarm。 

/s：queue size，你可以依需求調整。 

/f： 警報區域過濾。最多 15 個，若警報區域名稱有空白，請在警報區域名稱前後加

雙引號。若不指定表示全部警報區域都接受列印。 

Example: /fArea1 /fArea2 /fArea 

 

在 Start Up Mode，勾選 Background。最後按下 Add 按鈕 
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iCallAlarm 設定  

如同第二節 的 AlmUserQ.EXE 設定 

 

按下 Filename 右邊的[…]尋找按鈕，然後挑選 iCallAlarm.exe。 

 

在 Command Line 欄位可以不用輸入。但 iCallAlarm 提供的參數說明如下 

/LOG [選項]。代表啟動 Logging 功能。當此功能啟動，此程式會將錯誤訊息或發送的

歷史資料寫入 icallalarm*.log 檔案內，存放於此程式相同路徑下。 

/DELAY:x [選項]。延遲 iCallAlarm啟動的時間，單位為分鐘。大份應用在當 iFix 的 PDB

資料庫非常大時， iFix需要一段時間才能完全啟動。所以這時你可以使用此參

數。 

/RDD:x [選項]。當使用者按鍵發生錯誤時，可以許重新按鍵的次數。預設值為 3次。 

 

在 Start Up Mode，勾選 Normal。最後按下 Add按鈕 
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第五章  iCallAlarm警報語音檔錄製 

預錄語音檔格式 

iCallAlarm 系統所使用的預錄語音檔格式為： PCM , 44100Hz, 16bit,單聲道, 7KB/秒。 

 

自行錄製的語音, 應注意其音量不要過大或太小, 聲音要清晰。語音檔案名稱不可有空白

字元，需具有 WAV 副檔名。例如： 

語音檔名 = AI1.WAV 
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系統錄音檔清單 

以下錄音檔案已經錄製完畢，除非想要改用其他語音，否則不必再自行錄製。此為系統語

音，檔名自首為 sv_。 

語音內容 檔名 

請輸入密碼, 輸入完後請按井字鍵 sv_InputPassword.wav 

廠務系統有 sv_AlarmCount1.wav 

個警報發生 sv_AlarmCount2.wav 

聽下一個警報請按 1, 重聽請按 2, 確認警報請

按 3, 結束請按 0 

sv_AlarmMenu1.wav 

聽下一個警報請按 1, 重聽請按, 2 確認警報請

按 3 

sv_AlarmMenu2.wav 

重聽請按 2, 確認警報請按 3, 結束請按 0 sv_AlarmMenu3.wav 

聽下一個警報請按 1, 重聽請按 2, 結束請按 0 sv_AlarmMenu4.wav 

重聽請按 2, 結束請按 0 sv_AlarmMenu5.wav 

警報播放完畢 sv_AlarmPlayEnd.wav 

您好，這是語音警報系統 sv_Welcome.wav 

警報選單輸入錯誤，請重新選擇. sv_ChoiceAgain.wav 

密碼輸入超過時間,您無法進入本系統 sv_PasswordTimeOutExit.wav 

密碼錯誤已達次數,您無法進入本系統 sv_PasswordErrExit.wav 

密碼不正確, 請重新輸入密碼 sv_passwrodnotcorrect.wav 

輸入錯誤，請重新輸入 sv_InputError.wav 

超過輸入時間，請重新輸入 sv_InputTimeout.wav 

警報選單輸入逾時已達次數,結束通話. sv_AlarmMenuTimeoutExit.wav 

警報選單輸入錯誤已達次數,結束通話. sv_AlarmMenuErrorExit.wav 

語音警報系統發生錯誤 sv_SystemError.wav 

沒有警報 sv_SystemNoAlarm.wav 

找不到預錄的語音檔 sv_SystemNotFound.wav 

語音警報系統，迴路測試 sv_LoopTest1.wav 

號線測試完成 sv_LoopTest2.wav 

警報已經被管理者刪除 sv_AlarmDelete.wav 

模擬環境下, 不支援 TTS sv_TTSnotSupport.wav 

警報確認完成 sv_AlarmAckOK.wav 

警報確認失敗 sv_AlarmAckFail.wav 

Trendtek群
泰
科
技



iFIX 警報語音自動通報系統(iCallAlarm) 安裝手冊 

 

32 

 

警報確認點不存在 sv_TagNotDefined.wav 

號線路故障, 請派人前往處理 sv_TrunkFail.wav 

1 sv_1.wav 

2 sv_2.wav 

3 sv_3.wav 

4 sv_4.wav 

5 sv_5.wav 

6 sv_6.wav 

7 sv_7.wav 

8 sv_8.wav 

9 sv_9.wav 

0 sv_0.wav 
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預錄語音檔安裝 

請將所有自行錄製的語音檔案複製到 iCallAlarm 安裝目錄下的 Voices 目錄中即可。 
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第六章  TTS 文字轉語音 

iCallAlarm 支援 TTS(文字轉語音)的模式，先將要播放內容的文字輸入到標準的文字檔

案，副檔名必須為 txt，並將檔案複製到 iCallAlarm 安裝目錄下的 Voices 目錄中即可。 

 

TTS是「text-to-speech」的縮寫，也就是「文字轉語音」。如果你要使用 windows 中

文 TTS 的功能，例如語音辨識，那麼你必須外掛中文 TTS 語音引擎，你可以安裝 Microsoft

的中文 TTS語音或是另外花錢去買。預設 windows 內建的 TTS 語音是英文版本，且不同

windows 的安裝方式也有所不同。 

 

請參考下面說明如何安裝 Microsoft 的中文 TTS 語音 

 

6.1 Windows 8 TTS 語音安裝  

Windows 8 內建已經裝了「Microsoft Zira Desktop – English (United States)」女音和

「Microsoft Hanhan Desktop – Chinese (Taiwan)」女音。你可以再安裝其他 Windows 

8 附贈的「TTS 語音」。 

6.1.1. 進入「控制台\地區」，切換至「格式」頁面，然後按下「語言喜好設定」。 
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6.1.2. 出現「語言」畫面後，點擊「新增語言」。 

 

 

6.1.3. 出現「新增語言」畫面後，挑選你要的語言，點擊「新增」。 
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6.1.4. 接著又回到「語言」畫面後，在剛才新增語言右邊有一個「選項」按鈕，按一下此

按鈕。 

 

 

6.1.5. 出現「語言選項」畫面後，點選「下載並安裝語言套件.」按鈕進行安裝。 
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6.1.6. 安裝完成後，你可以使用語音辨識來測試一下，進入「控制台」\「語音辨識」，然

後點選視窗左邊的「文字轉換語音」。 

 

 

6.1.7. 出現「語音內容」畫面後，切換至「文字轉換語音」頁面，就可以看到預設使用的

是 Microsoft Zira Desktop – English (United States)小姐的語音庫，接著一定要將

「語音選取」改成 Microsoft Hanhan Desktop – Chinese (Taiwan)作為預設語音。 

你可以按「測試語音」按鈕來測試。 

記得最後一定要按下「確定」或「套用」按鈕，才會生效。 
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6.2 Windows 7 TTS 語音安裝  

Windows 7 內建的是「Microsoft Anna – English (United States」女音。你可以安裝

Windows 7 附贈的「簡體中文 TTS 語音」。 

6.2.1. 進入「控制台\地區及語言」，切換至「鍵盤及語言」頁面，然後按下「安裝/解除安

裝語言(I)…」。 

 

 

6.2.2. 出現「安裝或解除安裝顯示語言」畫面後，點擊「安裝顯示語言」。 
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6.2.3. 出現「安裝或解除安裝顯示語言 – 選擇要安裝的方法」畫面後，點擊「啟動

Windows Update」。 

 

 

6.2.4. 出現「Windows Update」畫面後，點選「35 個選用的更新 可以使用」。 
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6.2.5. 出現「選擇要安裝的方法」畫面後，點選「簡體中文語言套件…..」，然後按下「確

定」按鈕。 

 

 

6.2.6. 接著按下「安裝更新」按鈕，進行安裝。 
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6.2.7. 安裝完成後，你可以使用語音辨識來測試一下，進入「控制台」\「語音辨識」，然

後點選視窗左邊的「文字轉換語音」。 

 

 

6.2.8. 出現「語音內容」畫面後，切換至「文字轉換語音」頁面，就可以看到預設使用的

是「Microsoft Anna」小姐的語音庫，接著一定要將將「語音選取」改成 Microsoft 

Lili – Chinese (China) 作為預設語音。 

你可以按「測試語音」按鈕來測試。 

記得最後一定要按下「確定」或「套用」按鈕，才會生效。 
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6.3 Windows XP TTS 語音安裝  

Windows Xp 內建的是「Microsoft Sam」男音。至於安裝掛中文 TTS 語音引擎，你可

以： 

✓ 微軟網站下載並安裝 Speech SDK 5.1 與 Speech SDK 5.1 語言包 

(SpeechSDK51LangPack.exe)。 

✓ 安裝 Office XP 或 Office 2003。微軟在裡面加入了「Michael」和「Michelle」兩個

男女語音庫。值得一提的是，Office 2007 拿掉這功能了。 

 

6.3.1. 安裝完成後，就可以讓電腦說出中文、日文、英文，但 Speech SDK 5.1 的語言包

只有簡體中文跟日文，而要讓電腦說出中文，還必須去調整一些設定 

開啟 控制台 -> 語言 -> 文字轉換語音 -> 語言選取 -> Microsoft Simplified 

Chinese 
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第七章  測試 

⚫ 如果在 iFix SCU Task configuration 中有加入 iCallAlarm 時，建議將 iCallAlarm

順序放在最後一個啟動。 

請參考 iCallAlarm 操作手冊的，第三章第一節 一般啟動程序。 

 

執行 iCallAlarm 測試，故意由 iFix 產生一些警報，觀察是否正確撥出電話，是否正確播

放警報語音。如果沒有正常運作，請從頭檢查安裝過程有無疏漏。 
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第八章  異常排除 

 

Q：安裝語音卡之驅動程式 Dialogic System Software 途中，會顯示「Failed to set the 

environment variable (Path)」訊息? 

 

A：通常的原因為： 

1. 安裝時後的帳號權限不足。 

2. 你的 path 環境變數 environment variable (Path)的長度已經超過。 

 

Q：安裝語音卡之驅動程式 Dialogic System Software 途中，會顯示「Did not find a 

version of the Java Runtime Environment(JRE)..」訊息? 

 

A：按下「確定」按鈕即可。 

 

Q：安裝 API 軟體 CT ADE 時會發生「One or more files did not properly self-register」

的信息? 
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A：大部分原因是 CT ADE 安裝的版本，無法支援你現在 OS 的版本。例如 winXp 只能安裝

CT ADE 8.4.1 以前的版本。請移除已安裝的 CT ADE，在安裝適合的 CT ADE 版本。 

 

Q：安裝 iCallAlarm 時，會發生「註冊模組 ADXVoice.dll、ADXTTS.dll 失敗」? 
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A：因為你的系統已安裝的 ADXVoice.dll、ADXTTS.dll 版本，與 iCallAlarm 準備安裝的版

本不一樣，請按下「繼續」忽略他。 

 

Q：修復查詢 CT ADE 授權發生錯誤，查詢 CT ADE 授權(使用 Envox CT 

ADE→Common→CT ADE License Upgrade)發生錯誤 

 

A：解決方法 

必須完整移除 CT ADE(直接重新安裝或是選 Repair 都無效)，然後重新安裝一次。應該就

不會再發生錯誤。 

 

Q：修復 Envox CTADE ADX DLLs 存取被拒 錯誤 

 

A：解決方法 

重新安裝語音卡驅動程式或 Envox CT ADE 都無效。目前的辦法就是重新安裝作業系

統，再重裝 Envox CT ADE。 

 

Q：TTS 的語音速度如何調整? 

A：參考第六章，進入到「語音內容」畫面，調整語音速度。 
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